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1. Work area 
 
 
The main window of the program is divided into four sections: 
  
• the Menu bar includes all options listed in all menus. 
• the Toolbar includes the most used functions. 
• the Page displays the layout of the selected page. 
• the Information bar includes different tools useful to browse through the document pages. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 2.1 

Toolbar  

Menu bar 

Page  Information bar  
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1.1 Main settings 
 

 
This window is used to configure the main 
program settings and can be opened from 
File/Setup menu. 
 
Loading way: automatic or on row loading is 
possible. The second is only used when the 
test files can not be used with the automatic 
loading way1 
  
Automatic limits: two different algorithms 
are available to calculate limits in the graph 
axes. Generally the method called New is 
used. 
 
Language: the language to be used can be 
chosen. 
 
Network server: Cube2K can be used to 
print tests. This function can only be used 
combined to a program expansion not 
included. 
 
Print PDF: the PDF print driver can be 
selected among those available. 

                                                      
1 In case of doubts about the method to be used contact Testline. 
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1.2 Documents and tests 
 
Two different types of data files can be loaded with Cube 2000: 
 
¾ Tab-delimited text files – they need to be associated to a configuration 

 
¾ C2K proprietary binary files – resulting from the union of a tab-delimited text file and a 

display configuration. 
 
 
Two different procedures to open the two different types of file are available. 
 

 
1.2.1 Open a text file 

 
Select Open Tests in File menu and double click to select the desired test.  
Use CANC to delete one or more tests from the list. 

 
 

Up to ten tests can be selected at a time.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 This key is used to preview the selected file.  
 

 This key is used to indicate the number of lines to be displayed in the preview. 
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When you click OK the program asks to select the configuration to be used, if a new 
configuration must be created click New, otherwise choose among the configurations 
available. 

 
Configuration files are stored in the 
subfolder program CONFIGURATIONS 
and have CPF extension. 
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1.2.2 Open a C2K document file 
 

A document file is generated from one or more tests combined with a configuration file. 
 

TXT + CPF = C2K 
 

To open a document file click on Open document in File menu, and select the desired file. 
 
 
 
 

Fig. 2.3
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2. Main commands  
 
The documents generated by Cube are made up of pages.  
Each page can be a GRAPHIC or a REPORT page. 
A graphic page is used to display graphs, while a report page is used to create tables to sum up the 
data included in the document. 

 
 
2.1 Document pages 

 
To create a new page in a document select New page in Document menu, or click on the 
icon in the toolbar. 
 
To create a new page, name and type must be defined in the window. 

 
 
 
 

 
 
 
 

 
 

 
 
 
 
 
 

 
 
To delete a page from the document click on Cancel Page in menu Document, or click on the  
icon in the toolbar. 
 
 

Important: once cancelled a page cannot be recovered. 

Fig. 3.1 
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To rename a document page right click on the box in the page browser, or click Rename Page in 
Page menu. 

Page browser

Fig. 3.2
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2.2 Zoom functions 
 
Display size changes according to the zoom used. 
The keys used for these functions can be easily found in the toolbar. 
 
 
 
 
 
 
 
 
 
 
 
 

This key is used to display the full page in the window. 
 

This key is used to adapt the image in order to display max horizontal limits. 
 

This key is used to adapt the image in order to display max vertical limits. 
 

  
This box is used to adapt the size according to the % chosen. 

 
 
 
 
 
 
These keys are used to zoom in and out. 
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2.3 Toolbar additional functions 
  

 
This key is used to save the test in C2K document file format. The same operation can also be 
carried out using the key Save document in Document menu. 
 
 
This key is used to reach the print dialog window. The same operation can also be carried out 
using the key Print in File menu. 
 
 
This key is used to save the page displayed in Windows metafile format. This format is 
generally used when graphs are exported in other applications, or e-mailed to users working 
with Cube. 
This operation can also be carried out using the key Save image in Document menu. 
 
This key is used to save/load a configuration. 
The same operation can also be carried out using the keys Save configuration and Open 
configuration in Document menu. 
 
This key is used to open a window displaying document data. The same operation can also be 
carried out using the key Display data matrix in Document menu. 
When the document includes more than one test, also a selector will be displayed. 

 
 
 

Test selector 
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This key is used to open the print margin definition window. 

 

 
 
 
 

 
This function is present twice in Cube2K menu, once in Page menu and once in Document 
menu. In Page menu only the margins of the page displayed are modified while in the 
Document menu all pages will be updated. 
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2.4 Preferences 
 

The Setup/Preferences menu bring you to the general parameters definition window used to select 
the style for multi-test graphs, and the table used to translate labels. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
To define the test style, double click on the desired row 
and indicate in the window the desired features. 
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Click Define to reach the window where the translation table can be defined, and that is used to 
replace the names of the fields loaded from the file. 
 

 This key is used to copy labels from the test file, the other two keys are used to load and 
save translation files. 
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3. The graph 
 

 

3.1 Axes definition 
 

Cube2K can be used to create graphs having one X axis and many Y axes. 
 
To modify number and position of axes click on the icon in the toolbar, or click on Sections 
and Axes in Modify menu. 
 
 

 
The keys are only available in GRAPH pages. 

 
 

 
Click Section and Axes to enable the window (figure 3.1.1) where the number of sections2 and axes 
can be defined. 

 

To create a section select the  icon and 
click on the boxes indicating the two sides 
of the graph. The sections are always 
vertically aligned and can include a 
different number of axes. 
 
When a new section is created it only 
includes one axis, to add more axes use 

the  icon and click on the desired 
section. 
 
To delete an axis from a section use the 

 icon and click on the axis to be deleted. 

To delete a section use the icon  and 
click on the section to be deleted. 
 
 
 
 
 
 
 
 

 
Each side includes up to eight sections, and each section includes up to eight axes, that is 
64 axes for each side! 

 
 
 
 

                                                      
2 A section is an area including more axes that are horizontally aligned. 
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It is possible to modify height of sections in two ways: 

• Rapid method: click on the icon   , drag the mouse pointer on the horizontal lines limiting the 
section. 

• Precision method: click on the icon    to reach the window to define the section size. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This window is used to define with precision vertical dimensions of set sections. The values are 
considered as percentage of the space available in the graph, and must be whole numbers. 

 This key is used to assign the same value to all sections (please note that the space remaining 
from the percentage division - when present - is assigned to the last section). 
 

 This key is used to copy the dimensions set for one side for the other side. 
 

The summation  icon is used to calculate the total sum of set dimensions for the different 
sections.  
The program does not accept structures exceeding the sum of 100 for each side.

Fig. 3.1.2 
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3.2 Customizing axes 
 

To reach the window to customize axes double click on the desired axis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The configuration window is divided into three different pages: 
• format : groups all main axis settings 
• curve type: includes all functions concerning the display of values 
• advanced: includes special functions 

 
 

3.2.1 Format  
 

Channel label 

The list includes all test channels, use the icon   to assign a channel to the axis.  
 

  
One Y axis can include n channels, X axis only includes one channel. 

 
 

Use the icon  to delete the selected channel from the list. 

Use the icon  to delete all labels in the list. 
 
 

The use axis label box is used to indicate how to display labels.  
Three options are available: 

  
• Automatic: the program uses headers and measure units present in the test file. 
• Defined: the program uses the labels present in Label and Measure Units. 
• From external file: Test labels are replaced with those present in an auxiliary file. 

This option is very useful when strings are to be translated in other languages. 
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Limits 
This box is used to set numerical limits of the selected axis.  
With the automatic mode, the program looks for the ideal interval. 
With the manual mode it is possible to set the limits according to the following 
procedure: 

type the values in three of the four input cells available, and click the icon  
concerning the label to be calculated. 

 
Fonts 
Three fonts are available, respectively for: 
� Headers : axis label and measure unit  
� Numbers: numbers in the axis 
� Comment: comment string 

 
Pen style 

 
  
 
 
 
 
 
 
 

The use axis attribute box is used to choose between standard settings or in case 
of multi-test graph special settings according to main preferences3. 

 
Format 
It is used to set the numerical format to be used to display axis values.  

 
Subdivision nr. 
It is used to set the number of subdivisions desired between graduations. 

 
Grid 
It is used to reach the define grid window. 

 
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

The two boxes on the top page define thickness and style of grid lines. 
 
The Use subdivisions checkbox is used to generate grids considering and tracing 
the set axis subdivisions. 
 
 

                                                      
3 See Preferences on page 13 

Fig. 3.3 

Double click to select a colour 

Defines the stroke thickness  

Defines the stroke type  
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The colour of grid lines can be modified with a double click in the Colour box. 
 
The section Plot lines is used to define the lines to be traced. 
 
The Enable checkbox is used to enable or disable the grid. 

 
Add zero  
It is used to force the presence of the zero in axis limits. 
 
Logarithmic scale 
It is used to enable the logarithmic axis scale. 
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3.2.2 Curve types 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Four types of curve are available, more types can be used at the same time.  
 

o Linear: the curve results from the simple union of the acquired values. 
 

o Isolate points: the acquired values are represented by graphic symbols that can be 
customized in the following dialog window.  

 
 
 
 
 
 
 
 
 
 
 
 
 

o Interpolation: soft curves tending to approximate data distribution are generated. 
The selector on the right is used to indicate the interpolation level to be used. 
 

o Spline: a different interpolation method than the one just seen is used. It is possible 
to set 6 different interpolation types (0..5) and a percentage value defining the 
softness (the more the softness increases, the less the curve passes from the actual 
points). 
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3.2.3 Advanced functions 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Values filter 
The filter is used to reduce the number of data to be represented on one axis. It is necessary 
to indicate: 

1. the channel to be used as filter  
2. the type: Numeric to use a tolerance threshold, String to group similar 

elements. 
3. the value: the filter object deciding the selection criteria. 

 
Double axis 
One axis can have a second scale. The conversion box is used to add a formula to pass 
from the main scale data to the secondary scale data. To refer to the channel value use ‘X’ 
symbol. 
x.: X*2 creates a second scale with double values than the first. 

 
The meas u. box is used to indicate the measure unit represented by the new scale. 
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3.3 Graph property 
 

Select Graph property in Modify menu to enable this window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This window is divided into three sections: Definition, Graph and Legend. 
 
 

3.3.1 Graph 
 

1. Watermark: it is possible to set an image to be used as graph background. A BMP or 
JPG image can be used. Three different display modes are available: the first called 
Centered respects the image size, the second called Tiled repeats the image in order to 
full the screen while the one called Enlarge resizes the image in order to full the screen. 
 

2. Global Grid: it is used to activate a grid where all graph axes will be aligned and modified 
in order to align all subdivisions. It is important to note that the number of subdivisions 
set for the axes will be modified, and the space between graduations will be 
recalculated. 
When this function is enabled the number of subdivisions can not be modified in axes 
configuration. 

 
3. Border: it is used to define the type of border to be used for the graph. 
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3.3.2 Legend 
 

This object is used to differentiate the tests loaded in the graph. 
 

à Font: it is used to set the font to be used. 
à Alignment: the three keys are used to set the text alignment (left, right, center). 
à Border: it is used to select the type of border to be used. 
à Rows nr.:  it is used to set the number of rows for the text. Using for instance, the value 

1, the text will be aligned in a row, using a value equal to the number of tests a new row 
will be created for each test loaded. 

à Comments: it is used to add a text comment after the test name and style. 
à Common row: this row is used to add details present in the different test files. Click the 

icon  to reach the grid including the test details, the details can be copied from a cell 
in a text box just dragging them. For each test loaded a text row will be created including 
the details concerning the test. 

à Test name visualization: when this function is enabled, the program adds in each row 
the name and the path of the test files loaded. 

 
3.3.3 Definition 
 

Configurations of graphs can be saved and loaded. Files with “.CGF” extension are stored 
in the Configurations folder. This function is very useful to import graphs in a document.  

 
 
 

3.4 Channel type setting 
 

The type setting of axes is a very important function. It has already been explained  how to set a filter 
in the section devoted to axes properties, however a window is available for this function. 

The window can be activated through the Modify/Channel types menu or directly using the icon   
 
 
 
 
 
 
 
 
 
 
 
 
 
In this window the axes set in the graph are displayed in a grid, click on Channel Type box to select 
filter elements from the list. These elements concern the channel selected in the list Channel type. 
If the same filter is to be used for all channels, select the type in the filter box and confirm. 
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3.5 Dynamic reading of values 
 
 

It is sometimes useful to check the value of some points  
acquired directly just moving the pointer in the graph. This 

icon  activates the following window, where the value 
for each axis according to the mouse pointer position is 
displayed.  

  
Two options to display values can be enabled 
alternatively through two keys: 

  
actual value: this mode displays the value acquired 
nearer to the mouse pointer (the value displayed is 

always existent). 
 
 

position value: this mode displays the value concerning the position of the mouse pointer in 
the axis (the value displayed probably does not exist). 

 
 
 

The data numerical display is the same used on the axis. 
 
 



 

 

V. 1.5  Page 25

Definition grid 

Tools to customize 
the report 

Fig. 5.1 

List of channels

 

4. Report 
 
To obtain a new report a page must be created (see page 8), this page can be customized through 
Report Properties command in Modify menu. 
 
 

4.1 Creating a report 
 
The windows concerning report definition can be ideally divided into three sections: 
 
1. list of channels: on the left, it includes the list of all labels loaded in the test. 
2. definition grid: in the upper part of the window, it includes the groups and channels to define the 

report. 
3. tools to customize the report: in the bottom part they are used to set the report attributes. 
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4.1.1 Entering data in a report  
 

 
Definition of Groups and channels 
 
Cube 2K can be used to subdivide data in different groups, each group is identified by a row 
in the grid visible in the features window, each cell identifies a channel.  

 
Use the keys in this section to set the number of groups and the 
number of channels in each group. It is possible to add new 
groups or channels even when the report has already been 
created. 

 
 
 
 

To add a channel in a cell just drag it directly from the list into the desired cell. 
 

When the mouse button is released the name of the channel assigned 
is displayed in the cell, the number before the name indicates the test, 
to avoid confusion in case more than one test are included in the 
project. 

 
 
 
 

The selector to set the test the channel 
must be referred to is under the list of 
channels. 

 
 
 
 

 
Select one or more cells and use CANC to delete the text present. 

 
 

Empty cells are displayed in the report as columns without data, their size is set in 
the section attributes. 
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Cell attributes 

 
Each cell can be customized acting in the section Channels attribute. 

 

               
 
 

To set attributes first select the cell or cells to be modified in the grid, then set the desired 
attributes and click ASSIGN.  
 
Here is a short explanation of attributes: 
 
à Label Font: it is used to set the font used to display the label and the channel unit of 

measure. 
 
à Data font: it is used to set the font used to display the values. 
 
à Alignment keys: 2 groups are available, the first group acts on the channel alignment, 

the second acts on the data alignment. 
 
à Display format: it is used to set the format used for the channel numerical display. 
 
à Background colour: click on the cell to set the background colour. 
 
à Width in %: This cell is used to add a value to set cell width, the value is expressed in 

percentage on the total space available for the report. This parameter is only considered 
when Planned mode is used to determine report columns width (see following sections). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 5.2 
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Report main settings 

 
The following sections to customize the report affects the whole report, not only one or more 
channels. 

 
The Columns width section is used to define the mode to divide the space. Three modes are 
available: 

Automatic: the program sets columns width according to the 
space necessary to display the data. 
Homogeneous: the space available is divided into the report 
number of channels. 
Planned: each column is sized according to the width in 
percentage set in the channels attributes section. 

 
If you are not using the homogeneous mode (in this case in the worst conditions 
columns could be narrower than necessary), a special attention must be paid as 
the columns could exceed the max right limit. In this case the space used must be 
reduced (for instance reducing the font size), or the group must be divided in two 

    groups.  
 
 

The section Lay-out is used to set some main features of the 
report layout: 
Rows differentiate: it is used to underline rows in the report 
alternating two different colour tones that can be adjusted in 
the boxes below as rows background.  
Grid: it is used to enable a grid around the document. The 
trackbar on the right is used to set the thickness of the grid 
lines. 
Break group level: it is used to force the page break at the 
beginning of each new group. 
Rows numeration: it is used to add an automatic counting 
column. 
Alignment: it is used to indicate the report aligning in the 
page. 
Repeat header and Repeat footer are used to print footer 
and header in all pages instead of limiting header to the first 

page and footer to the last page. 
 
 

The section Report margin is used to set special differences.  
 

Upper: it is used to create a distance between the report 
beginning and the upper margin. 
Lower: it is used to create a distance between the report and 
the lower margin. 
Between groups: it is used to leave a space between one 
group and the other. 
Column gap: it is used to increase the space of each column 
when the automatic mode is set. 
Re-entry: it is used to set an additional margin to the left side of 
the document. 
Footer at bottom: it is used to indicate where the footer needs 
to be printed. When enabled the footer is always printed at the 
bottom page, on the contrary a space set as lower margin will 
be left between the footer and the last report row. 
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The section Titles and Filters is used to differentiate the groups created with reference to a 
preset channel. 
Once the channel to be used as discriminant has been selected (Use channels box), the list 
of all different elements present in the selected channel will be displayed in Types box (up to 
100). 
The right cell includes the list of set groups. To assign a channel type to a group first select 

the desired  channel type, then select the group and click the icon  . 
 

 

If you want to delete the channel type from the group select the group and click the icon  
. 
 

The   icon is used to delete a whole group, that is both the row in the channel grid and 
the row in the list representing it. 
To temporarily disable a group display, disable the cell near each element of the list, ex.: 
 

in this case 2 groups are displayed, the first is enabled 
(and visible in the following printout) while the second is 
disabled (and will not be displayed in the printout). 

  
 
It is also possible to assign titles to the different groups, write the text in the box on the 

bottom page, select the group to title and click  . 
To print titles activate the box Groups title and choose type of aligning and font. 
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Load and save a report model 
 

It is possible to save the report configuration.  
This function is very useful to import reports already created in new documents. 

 
All report configuration files have CRF extension, configurations can be loaded and saved 
using the two keys in the left upper corner of the configuration window. 

 
 

 
 

 
 

Example of report obtained by the  
program. 

 pag. 1 di 8

Caratteristica magnetica - Magnetic characterisc

Freq. Cond. Vlinea Vavv. Vcond. Im Ia IL Pot. Ass. Cos‹ Giri
Hz ”F V V V A A A KW min-¹

50 30,0 136 202 249 1,24 2,34 1,14 0,13 0,858 1484
50 30,0 148 217 270 1,50 2,53 1,13 0,15 0,904 1485
50 30,0 159 231 290 1,82 2,72 1,13 0,17 0,949 1485
50 30,0 171 243 309 2,22 2,90 1,18 0,19 0,958 1486
50 30,0 182 254 327 2,72 3,07 1,35 0,22 0,885 1486
50 30,0 195 265 347 3,52 3,26 1,81 0,25 0,719 1487
50 30,0 205 273 363 4,30 3,41 2,42 0,30 0,599 1487
50 30,0 219 281 383 5,52 3,60 3,48 0,38 0,498 1488
50 30,0 229 287 398 6,66 3,76 4,53 0,48 0,460 1487
50 30,0 241 294 418 8,29 3,97 6,08 0,65 0,444 1486
50 30,0 254 300 438 10,00 4,18 7,74 0,90 0,459 1485

Coppia massima - Max torque

Freq. Cond. Vlinea IL Pot. Ass. Cos‹ Coppia V nom I rapp. C rapp. Cmax/Cnom
Hz ”F V A KW Nm V A Nm

50 30,0 228 9,02 1,99 0,968 9,1 230 9,08 9,3 1,9

Rendimento ai vari carichi - Efficiency at the different loads

Freq. Cond. Vlinea Vavv. Vcond. Im Ia IL Pot. Ass. Giri Coppia Pot. Resa ‰ Cos‹
Hz ”F V V V A A A KW min-¹ Nm kW %

50 30,0 229 279 381 5,44 3,59 4,39 0,74 1441 2,4 0,37 50,0 0,731
50 30,0 230 279 380 5,43 3,58 4,58 0,80 1433 2,9 0,43 53,9 0,763
50 30,0 228 275 372 5,02 3,50 4,57 0,86 1419 3,5 0,52 59,8 0,829
50 30,0 229 274 370 5,02 3,49 4,77 0,93 1409 3,9 0,58 62,3 0,854
50 30,0 230 271 367 5,03 3,45 5,06 1,03 1394 4,6 0,67 64,9 0,884
50 30,0 230 269 362 5,00 3,41 5,30 1,11 1380 5,1 0,74 66,7 0,909
50 30,0 230 265 357 5,08 3,36 5,62 1,20 1363 5,7 0,81 67,6 0,928
50 30,0 230 260 351 5,24 3,31 6,01 1,31 1342 6,3 0,89 67,9 0,944

BOLLETTINO DI COLLAUDO - TEST CERTIFICATE

 Tipo motore KLB12      Data :  23/02/2007
DATI MOTORE

Alimentazione : Monofase Matricola : 123456 Forma : B5 Cliente :- - - - -

V Nom. [V]  : 230v Frequenza [Hz] : 50 P Nom. [KW] :0,75 C Nom. [Nm] : 5 Giri [min-¹] : 1360

I Nom. [A] : 5,05 P ass. [KW] : ‰ [%] : Cos Í : 0,95 Poli : 4

Condensatore [”F] : 30 Grado Protezione : IP55 Classe isolamento : F Servizio : S1

DATI COSTRUTTIVI
 Ø est. lam. [mm] :  Ø int. lam. [mm] : H pacco [mm] : Ø albero [mm] :  Lung. albero [mm] : 

 No. cave statore :  No. cave rotore : 

DATI AVVOLGIMENTO MARCIA

Fili cava :  Passo cava :  Ø filo [mm] :  Isol. cava :  Treccia [mm²] : 

DATI AVVOLGIMENTO AVVIAMENTO

Fili cava :  Passo cava :  Ø filo [mm] :  Isol. cava :  Treccia [mm²] : 

FILE DATI :  C:\Elektro\Prove\Monofase\M80\M80 B-4 B5 0512-68661 SPZ.TXT
NOTE :    
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5. Header and footer 
 

Sometimes additional details or comments need to be included, the program offers an object to 
obtain a high configuration of the sections header and footer. 
 
These objects can be displayed using commands Header and Footer in the Page menu. 
 

 

 pag. 1 di 1

Caratteristica magnetica - Magnetic characterisc

Freq. Cond. Vlinea Vavv. Vcond. Im Ia IL Pot. Ass. Cos‹ Giri
Hz ”F V V V A A A KW min-¹

50 30,0 136 202 249 1,24 2,34 1,14 0,13 0,858 1484
50 30,0 148 217 270 1,50 2,53 1,13 0,15 0,904 1485
50 30,0 159 231 290 1,82 2,72 1,13 0,17 0,949 1485
50 30,0 171 243 309 2,22 2,90 1,18 0,19 0,958 1486
50 30,0 182 254 327 2,72 3,07 1,35 0,22 0,885 1486
50 30,0 195 265 347 3,52 3,26 1,81 0,25 0,719 1487
50 30,0 205 273 363 4,30 3,41 2,42 0,30 0,599 1487
50 30,0 219 281 383 5,52 3,60 3,48 0,38 0,498 1488
50 30,0 229 287 398 6,66 3,76 4,53 0,48 0,460 1487
50 30,0 241 294 418 8,29 3,97 6,08 0,65 0,444 1486
50 30,0 254 300 438 10,00 4,18 7,74 0,90 0,459 1485

BOLLETTINO DI COLLAUDO - TEST CERTIFICATE

 Tipo motore KLB12      Data :  23/02/2007
DATI MOTORE

Alimentazione : Monofase Matricola : 123456 Forma : B5 Cliente :- - - - -

V Nom. [V]  : 230v Frequenza [Hz] : 50 P Nom. [KW] :0,75 C Nom. [Nm] : 5 Giri [min-¹] : 1360

I Nom. [A] : 5,05 P ass. [KW] : ‰ [%] : Cos Í : 0,95 Poli : 4

Condensatore [”F] : 30 Grado Protezione : IP55 Classe isolamento : F Servizio : S1

DATI COSTRUTTIVI
 Ø est. lam. [mm] :  Ø int. lam. [mm] : H pacco [mm] : Ø albero [mm] :  Lung. albero [mm] : 

 No. cave statore :  No. cave rotore : 

DATI AVVOLGIMENTO MARCIA

Fili cava :  Passo cava :  Ø filo [mm] :  Isol. cava :  Treccia [mm²] : 

DATI AVVOLGIMENTO AVVIAMENTO

Fili cava :  Passo cava :  Ø filo [mm] :  Isol. cava :  Treccia [mm²] : 

FILE DATI :  C:\Elektro\Prove\Monofase\M80\M80 B-4 B5 0512-68661 SPZ.TXT
NOTE :    

Note di costruzione:

 

Header 

Footer 
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5.1 Modify Header or Footer objects 
 
Double click on a header/footer object to reach the window to customize the object. 
 
   
 
 
 

 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
The window includes an upper bar, including the keys, and a page divided into four sections:  
Text, Back and border, Columns and rows and Utility. 
 
 
5.1.1 Toolbar 
 

 
 

Important functions are included in this bar: 
 

� The first 2 keys (1 and 2) are used to respectively load and save a header/footer file. 
These files have CIF extension. 

� Key 3 is used to undo the last action. 
� Keys 4, 5 and 6 are used respectively to Copy, Cut and Paste the text in selected cells. 
� Key 7 is used to select all grid cells. 
� Key 8 opens a window including all details loaded by the program during test opening. 

 
  
 
 
 
 
 
 

Test selector 

Fig. 5.1 

Toolbar 

Page with functions 
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This window includes a grid with all details stored in the starting test file, and a lower bar 
used to select the desired test. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A detail can be dragged from the information grid to the header: select the detail in the 
information cell, click left and keep it down and then move the pointer inside the header cell 
where the detail needs to be added.  
 

The information window can only be closed clicking on the key information (8) 
already used to enable it. 

 
 
The key 9 is used to disable the manual resizing of grid cells. This function is very useful and 
prevents unwanted changes in the cell size. 
 
The key Update (10) is used to assign the changes made in the cell to the selected object. 
 

Important: setting changes will not be assigned if not confirmed using the key 

. 
 

 



 

 

V. 1.5  Page 34

5.1.2 Text 
 

To enter some text in a cell select the cell and reach the text section of the customize page. 
 

In the box on the top the text to be 
added in the selected cell can be 
entered. 
The font to be used can be set using 
the key Font. 
The program includes the possibility to 
set the text horizontal aligning using the 

three keys,  or the 
vertical one using the keys  

 
  
  
  
 
The cell Text orientation is used to indicate whether a vertical or horizontal text orientation 
is desired. 
 
The box Cell limited is used to indicate whether the added text must be included in the cell 
or can exceed the limits. 
 
The key Add details is used to include a value in the test data matrix. Use this key to reach 
the following window. 

 
 

First set the test to extrapolate the value from among 
those loaded and the channel. Then some functions can 
be used to choose the value: 
à Value: it is used to set in the box on the right the 

index for the value to display (0 stays for the first 
value) 

à Min: it is used to set min. value for the channel 
à Max: it is used to set max value for the channel 
à First:  it is used to add the first value acquired 

(corresponds to the function Value with index 0) 
à Last: it is used to add the last value acquired. 
à The box Decimals is used to set the number of 

decimals to be used to represent the value. 
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5.1.3 Back and border 
 
 This section is used to modify some 

features of grid cells.  
 

Click on the 4 boxes representing the 
cell borders to enable alternatively 
three different options: 
Grey: to keep the border as it is.   
Black: to make the border visible. 
White: to make the border invisible. 

 
These three keys 
force the solutions 

described on all four borders at a 
time. 

 
Contrary to the border box acting 
only on external borders of the 

selection, the Grid border checkbox is used to activate all borders of the selected cells, 
including the borders inside the selection. In the same way Clean border deletes all borders. 
 
The section Bitmap is used to load images in Bmp/Jpg format to be included in the selected 
cells, positioning of these images is carried out according to three different modes: 
 
• Real with scale mode: the image is displayed using the file original dimensions according 

to a scale parameter including values from 0 to 1. For instance when this parameter is 
set to 1 the image original dimensions are displayed, while when it is set at 0.5 the 
image dimensions will be halved. 

• Proportional mode: the image is resized uniformly on the two axes in order to be 
contained in the selected cell. 

• Distorted mode: the image is resized according to the cell dimensions in order to fill the 
cell. 

 
 
 
5.1.4 Columns and rows 
 

This section is used to define the number of 
columns and rows in the header. In the cell 
Grid dimension the desired values can be 
entered. 

 The four keys in the lower left corner are 
used to add/remove new rows or columns 
according to the selected position. 

 Normalize keys are used to equally divide 
the space in the selected rows or columns. 
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5.1.5 Utility 
 
This function is used to automatically modify the references of the fields in the cells. 

 
 
 
 
 
 

 
A data field is a special code referring to a set position present in the test file. As already seen it 
is possible to add a data field in the text box cell using the selection window (see par. 5.1.1 key 
nr° 8). This field has the following format: 

 
&<1;1;5(Code)>  
 
where: 
 
&< : is the tag indicating the beginning of reference data field, concluded by )>. 
 
The three following numbers, separated by a semicolon, identify respectively the test number 
(from 1 to 10), the column index and the row index. The text included in the cell is indicated in 
brackets. 
 
The shift function is used to shift row references present in the data fields, that is to modify the 
third number indicated in the reference field. 
The procedure asks to indicate the row to start with and the number of offset rows (when 
negative values are put, references will be shifted backward) 
 
In short, if the value 5 is entered in the field From row and the value 1 is entered in the field 
rows nr. after clicking on shift row references all fields including row references from 5 on will 
be increased by 1. 
 
The field &<1;1;5(Code)> will pass to &<1;1;6(Code)> 
In case the field were &<1;1;4(Code)> it would have remained unchanged. 
 
 

Important: this function is always applied to all header cells and not only to the 
selected ones. 
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6. Tools 
 
In the tools menu some functions are present that are not strictly linked to the creation of graphs and 
reports, but can be useful for many requirements. 
 
 

6.1 Tests normalization 
 

The command Test normalization in the Tools menu is used to create a new file starting from a test 
file including values calculated through interpolation of actual values. 
In short a test can be used to create a new file including data obtained by the program applying the 
functional interpolation algorithm to round curves instead of starting data. 
 
When the test to be normalized is selected, the following window is displayed. 
 

 
 

On the left the list of channels loaded from the test is displayed. Select the channels to be included in 
the new file from this list using the following keys: 
 

 It is used to add the selected channel in the list of normalization channels 
 

 It is used to delete the selected channel from the normalization list 
 

 It is used to move the channel selected in the position above into the normalization list 
 

  It is used to remove the list with normalization channels 
 
 
When a list is created always consider that the program needs a channel to be considered as an 
independent variable to carry out the operation, that is a channel that in the graph would be traced 
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on the abscissas axis. The program uses as independent variable the first channel present in the 
normalization list. 
 
When the desired channels have been included in the normalization list the precision degree must 
be chosen. A higher degree results in an interpolation reproducing a more similar representation of 
the points distribution supplied; in general the interpolation degree is inversely proportional to the 
number of values present. With few vales it is suggested to use a high degree while with many 
values it is better to use a low degree to better represent the points distribution. 
 
The program also required to enter a resolution, representing the min. number of points that will be 
calculated by the algorithm and included in the new file. 
 
To have an idea about the result strike the key Preview to display the calculated values in the graph, 
the green curve represents the data present in the starting file while the red one represents the data 
after interpolation. 
 
When the desired result has been obtained the procedure can be terminated using the key Create 
file.  
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6.2 Tests conversion 
 
The program includes a section dedicated to some conversion procedures that can be applied to 
tests. Two conversion types are available: 
 

1. Test conversion in C2K format 
2. Insert data fields 

 
To reach conversion window choose Tests conversion in Tools Menu. 
The following window is displayed: 
 

 
 
The window is articulated in different sections, some are common to both conversion types others 
are only valid for one of the two. 
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6.2.1 Select test 
 

This section is used to select the 
tests to be  converted. 
To add a test file use the key Add 
test and select the desired file, while 
to add the text of a folder use the 
key Add folder. 
The cell Consider sub-folder is used 
to  activate conversion of all files in 
the selected folders. 
The key Delete deletes the selected 
item from the conversion list, while 
the key Clear eliminates all items in 
the list . 

 
 
6.2.2 Filters 
 

In order to select the tests included in one or 
more folders  a filter can be created to convert 
only the files having the required features. 

 
The key Add is used to add a new filter, for 
instance it is possible to tell the program to 
convert only TXT files  typing *.TXT. 

 
 
 

This function uses the Windows wild cards concerning the following characters: 
 

“*” (star): meaning “all”, very useful to select a group of files: 
*.txt = all files with txt extension 
*test.* = all files ending with test with all extensions  
test*.txt= all files starting with test and having txt extension 

 
“?”: meaning all fonts, acts as the * but is only valid for a character: 
test?.txt= all files starting with “test” and including a different character and having “txt” 
extension, for instance the filter would include a file called test1.txt while it would exclude a 
file called test10.txt, that in order to be included would need a filter like test??.txt or more 
simply test*.txt. 

 
 

6.2.3 Test conversion in C2K format 
 

This function is very important. It is 
used to change a test or a test file 
into C2K format (for further details 
see paragraph 2.1.2 Open a 
document file).  
Select the C2K folder from the 
conversion window in the section 
Conversion way type. 

 
Before launching the conversion procedure select the configuration model to be associated 
to all files to be converted. The models available are included in the list “Join to configuration 
model”. It is not possible to convert tests without having selected the configuration model. 
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During conversion, all files created will be included in the same starting folder, replacing the 
old extension with C2K. If the old extension of tests is not to be cancelled it is possible to add 
it after the file name, enabling the function Add old file mask. 
In short this function converts the file as shown below: 
 
Starting file:   Test1.txt 
Converted file: Test1txt.C2K 
 
Use Convert to start the procedure and convert in C2K the selected files.  
 

A  C2K file can be opened directly without a display configuration, and in 
addition can be opened directly using C2K Reader. 

 
 
 
6.2.4 Insert fields 
 

This function is used to add 
some data fields in test files 
already created. According to 
the acquisition program used it 
is necessary to add one or 
more motor data. In order to 
obtain new test files compatible 
with files already created the 
missing  data can be added. 
The row where new fields will 

start to be added can be set in the Index starting translation box.  The key Add is used to 
add a row, the key Delete is used to delete the selected row in the list, and the key Clear is 
used to eliminate all text. 
 
In the section New file creation settings it is possible to set whether the new file should 
replace the old one or it should be included in a new path. 
When tests are created with automatic loading way format (in the test file the first field is a 
value indicating the row where the acquisition data matrix starts), the reference value can be 
automatically corrected enabling the box Start data index incrementation. 

 
The key Convert enables the selected conversion procedure. 
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7. Tests editor 
 

The program includes an editor to be used to work with tab-delimited text files, and to read test files 
created using all Testline acquisition programs. Use the key Edit test in File menu to reach this 
function.  
 
Once the test has been loaded in the file the following functions will be available 
 

 These keys are used to open a new test file and to save a modified test file. 
 

 This key is used to copy the text in the selected cells (shortcut keys CTRL + C) 
 

 This key is used to cut the text in the selected cells (shortcut keys CTRL + X) 
 

 This key is used to paste the text copied (shortcut keys CTRL + V) 
 

 This key is used to lock the column of the selected cells, in order to scroll the others keeping a 
part locked. 
 

 This key is used for the same function just described but is referred to rows.  
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A.1 File formats 
 
  The program uses many types of file, the following list should help to identify them: 
 

1. CPF : the project configuration format (Cube Project File) includes all project configurations, 
graphs, header reports. The file includes only display details, data are loaded apart. 
These files can be saved or loaded in Documents menu, using the commands Save project 
or Load project. 

 
2. CRF: the report configuration format (Cube Report File) includes the report configuration. It 

is very useful to load a report already made and then modify it. 
This file can be loaded using the keys inside the report configuration window. 
 

3. CGF: the graph configuration format (Cube Graph File) includes all graph features. This file 
is used to exchange graphs between different projects. To load/save these files use the 
commands Save Graph and Load Graph in Page menu (only visible in graphic pages). 
 

4. CIF: the header/footer configuration format (Cube Header File) includes all header/footer 
features. 
To save or load these files reach the header/footer configuration window and use the first 
two keys on the left. 

 
5. C2K: this document file, differently from all other files including only details to display a test 

file, also includes the test data. In short it combines a CPF file and a test file created by the 
acquisition program. 
Reach Load Document in File menu to load this file, while Save Document in Document 
menu can be used to save the file. 

 
 

Chart: 
 

 

Test file 
Generated by the 

acquisition software 
program  

CPF file 

Document 
including 

graphs and 
report  
pages 

CRF file 

CGF file 

CIF file 

C2K file 


